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We are seeking vector and/or digital art from various mediums that is eye-catching and thought-provoking. Submissions 
have the possibility to be prominently displayed on Loma Linda University Health signage. Signs are designed towards a Health 
District concept to support the continual healthcare expansion and promote public safety by creating a seamless experience to 
the motorist in finding major inbound destinations throughout the city and around large campuses. Branding on the front of the 
sign cabinet is a visual vocabulary defining the district, where public art on the back of the cabinet provides general aesthetics, 
and more importantly a functional element of re-enforcing a sense of awareness that you are in a health district thru a wellness 

theme. For this purpose, we have created this unique opportunity for the Loma Linda community, and have extended this 
program scope to include students, and those affiliated with an art association or club to submit art work. 

RULES AND REGULATIONS:

LOMA LINDA COMMUNITY PUBLIC ART PROJECT

ALL FILES ARE BUILT TO REQUIRED SIZE AND RESOLUTION SPECIFICATIONS
For all bitmap images, artwork must be built to the specific sign dimensions at 150dpi (example: Gateway 

Sign - 11'-6.5" (h) x 4'-8" (w) at 150dpi).  Visit www.lomalindaartsigns.com  for all sign types, size and resolution 
specifications. Each entry will have to submit 2 files, First your initial entry that will be 25% of the final size 

artwork. If your entry is selected you will be contacted by a LLCPAP representative, they will give the details 
on how to upload the final size art. For bitmap images - DO NOT USE FINAL ART AS YOUR ENTRY.  

YOUR ENTRY NEEDS TO MEET OUR THEME REQUIREMENTS
Themes: Shine, Serve, Move, Breathe, Learn, Refresh, Eat Well, Rest

Each entry must emphasize one of defined themes. 

HUMAN PHOTOGRAPHY CANNOT SHOW A RECOGNIZABLE FACE

AVOID USING TEXT MESSAGES IN THE ART WORK

IF YOU HAVE ANY QUESTIONS 
Please contact us at KSharp@lomalindaartsigns.com
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SIGN TYPES AND SIZES:
GATEWAY

FINAL SIZE : Final artwork must be 11'-6.5" (h) x 4'-8" (w) at 150 dpi
ENTRY SIZE: 2’-9.12”x 1’-2” at 72 dpi  (25% original size) - For Judging purpose only.  

OVERROAD
FINAL SIZE : Final artwork must be 11'-8" (t) x 4'-8" (w) at 150 dpi

ENTRY SIZE: 2’-9½”x  1’-2” at 72 dpi  (25% original size) - For Judging purpose only.  

THRESHOLD
FINAL SIZE : Final artwork must be 11'-2" (h) x 4'-6" (w) at 150 dpi

ENTRY SIZE: 2’-8”x 1’-1.15” at 72 dpi  (25% original size) - For Judging purpose only.  

VEHICULAR
FINAL SIZE : Final artwork must be 7'-10" (h) x 8'-0" (w) at 150 dpi

ENTRY SIZE: 1’-7.75”x 2’ at 72 dpi  (25% original size) - For Judging purpose only.  

GATEWAY
11'-6.5" (h) x 4'-8" (w) 

THRESHOLD
11'-2" (h) x 4'-6" (w)

OVERROAD
11'-8" (t) x 4'-8" (w)

VEHICULAR
7'-10" (h) x 8'-0" (w)



Line Art/Vector Art

Line art is usually created in software such as Adobe Illustrator, Corel Draw or similar programs. These images are created with 

vector based shapes that are filled with solid colors or gradations between solid colors.

When color is critical: you must provide Miratec Systems with color chips, Pantone numbers or a standard vinyl color from a 3M, 

Arlon, Avery or Oracal color library that we can use to color match solid fill areas. Any critical colors should be listed in the file’s 

color swatch palette. The intended parts of the art should actually use each indicated color swatch. We can produce these 

graphics without a color reference; however, the color could possibly look different than your expectations.

COLOR

CMYK Color

Use CMYK when preparing art files for production. CMYK will most accurately reflect onto your computer monitor, the output 

color, although there may remain some subtle differences.

RGB Color

While we accept RGB files, differences in color can occur when they are converted to CMYK for production.

Resolution

Pixel images are made up of many small squares of data called pixels. The data in each individual square dictates the color that

the pixel will print. Resolution is defined by the number of pixels in a given area of an image.

BITMAP IMAGES

Pixels Per Inch (PPI)

PPI is the most common measure of resolution. Knowing and understanding your image’s PPI is important for scaling purposes 

because the overall number of pixels in a piece of art does not change as the dimensions change. However, the PPI does change 

as the dimensions change. The pixels merely get bigger or smaller in concordance with the image size. Thus, PPI is inversely 

related to dimension; as an image is enlarged, the pixels are also enlarged and there are fewer of them per inch.

Determining Adequate Resolution

Determining adequate resolution for pixel art is dependant on the application and its true viewing distance. A billboard viewed 

from a highway 500’ away may only need to be set to 25 ppi at full scale. On the other hand, a graphic installed in an airport 

concourse, intended to be viewed from only a few feet away, may need to be 400 ppi or more at full scale.

Increasing Resolution

While there are methods for increasing the number of pixels per inch, understand that information not contained in original art 

cannot be “created”. We can increase the pixel count of an image but we cannot produce high resolution graphics from pixel 

format files that are supplied to us at low resolution.

When an image is artificially “res-ed up”, or has had its pixel count artificially increased it can “soften” the “stair step” effect but, 

at the same time, can cause the image to have a slight “blurriness.” Artificially adjusting the image’s resolution will not make the 

image look clearer or sharper.

As a rule of thumb, when working with pixel art, try to work at full scale whenever possible and determine the appropriate 

resolution based on the final viewing distance.

High Quality Resolution

High quality art is required to achieve the best printing results. When working with digital photos there is no substitute for high 

quality professional digital photography. Keep in mind that a 10 mega-pixel camera will only create a 100 ppi image when scaled 

up to 32”x32”. Techniques can be used to further enhance images, but there are always limits to what can be done, and the larger 

the output dimensions become, the more that pixel count and clarity matter.

For Example:

This 10” x 10” image has a resolution of 100ppi, while the 20” x 20” image has a resolution of 

50ppi. Both images have the same number of pixels overall, however the pixels are stretched 

over differing dimensions thus changing each image’s respective ppi.

If the output/final size of the image is large and the pixel count (PPI) is 

small, the result will reveal square, “stair step” shaped pixels as shown in 

the far right example. This may be acceptable based on a long viewing 

distance. However, in cases where your art will be viewed closely, higher 

resolution artwork may be necessary.

FILE FORMATS

Adobe Photoshop

Adobe Photoshop is a pixel based software program and the industry standard for image manipulation. 

We can accept all Adobe Photoshop generated files regardless of type; however, we do request that they are provided to 

us in CMYK mode for best results.

Adobe Illustrator

Adobe Illustrator is a vector based graphic program commonly used for type or line art either alone or in conjunction 

with pixel images.

IMPORTANT: When including type in your graphic all fonts should be converted to outlines!

To convert your file to outlines in Adobe Illustrator:

Select all elements of the graphic

Click on the “Type” Menu

Select “Create Outlines”

Adobe InDesign

Adobe InDesign is a vector based program, similar to Illustrator; however, InDesign gives the user a higher degree of control 

over text elements. When using InDesign export your artwork to a PDF document.

Corel Draw

Corel Draw is a popular program for desktop publishing and creation of graphics, however, we do not recommend using Corel 

Draw to create graphics for large format output. Art files output from Corel Draw have a tendency to have unexpected results at 

the printer, i.e. shadows, shading, pattern fills and gradients created in Corel Draw. In addition, exporting Corel Draw files out to 

other file formats such as EPS or AI can also yield unexpected results such as missing elements, color banding, etc.

With that being said, we will accept Corel Draw files, but we ask that you have all elements in CMYK mode and be sure to also 

supply us with a pixel format file (such as a JPEG) that accurately represents the desired look and layout of your graphic. This will 

enable us to confirm that no elements are missing or distorted as we go into production.

IMPORTANT: When including type in your graphic all fonts should be converted to Paths/Curves!

To convert your file to Path/Curves in Corel Draw:

Select all elements of the graphic

Click on the “Arrange” Menu

Select “Convert to Curves”
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DIGITAL ART REQUIREMENTS
When providing us with artwork for production, please note the following digital art requirements.

SUBMITTING ART FILES
Art files smaller than 10MB:

Art files smaller than 10MB can be attached to an email sent directly to an assigned address.  If you are a winner a 

representative will contact you.

Art files larger than 10MB: 

Art files larger than 10MB should be submitted via the FTP (File Transfer Protocol) site which is available for customers to 

upload files into their respective, password-protected folders. If you are a winner a representative will contact you.

DIMENSIONS
Visible Opening (V.O.)

The visible opening is the portion of the graphic that is visible within the framework. The V.O. dimensions assure that none of the 

graphic’s elements are hidden or obstructed by the framework/cabinet.

COLOR BLEED
Color bleed is the extra printed material necessary to accommodate a framework, if any. This is critical even if the background 

color is white. Color bleed will ensure that when your graphic is installed there will be no “light leaks” between the graphic and 

its frame. If color bleed is required, add the proper amount to your artwork before submitting your job for production.

OVERALL SIZE (O.A.)
The overall size is the size of the substrate to which the graphic is applied. In some cases this dimension may be the same as the 

V.O. plus any color bleed.

ART TYPE
Oftentimes, a graphic is composed of a combination of pixel art and line art. In this case, both of the following conditions apply 

and should be considered before submitting your art.

Pixel Art

Pixel art is a form of digital art comprised of continuous color gradations.

When color is critical: you must provide Miratec Systems a color proof that we can match. If you cannot provide a color proof, 

we’ll run your graphics “as provided” with the understanding that the color could possibly look different than your expectations.

Unacceptable color proofs: Prints via desktop printer or colors from a computer monitor

Acceptable color proofs: Matchprints, Iris, Fiery, etc.



When providing us with artwork for production, please note the following digital art requirements.

SUBMITTING ART FILES
Art files smaller than 10MB:

Art files smaller than 10MB can be attached to an email sent directly to an assigned address.  If you are a winner a 

Representative will contact you.

Art files larger than 10MB: 

Art files larger than 10MB should be submitted via the FTP (File Transfer Protocol) site which is available for customers to 

upload files into their respective, password-protected folders. If you are a winner a representative will contact you.

DIMENSIONS
Visible opening (V.O.)

The visible opening is the portion of the graphic that is visible within the framework. The V.O. dimensions assure that none of the 

graphic’s elements are hidden or obstructed by the framework/cabinet.

COLOR BLEED
Color bleed is the extra printed material necessary to accommodate a framework, if any. This is critical even if the background 

color is white. Color bleed will ensure that when your graphic is installed there will be no “light leaks” between the graphic and 

its frame. If color bleed is required, add the proper amount to your artwork before submitting your job for production.

OVERALL SIZE (O.A.)
The overall size is the size of the substrate to which the graphic is applied. In some cases this dimension may be the same as the 

V.O. plus any color bleed.

ART TYPE
Oftentimes, a graphic is composed of a combination of pixel art and line art. In this case, both of the following conditions apply 

and should be considered before submitting your art.

Pixel Art

Pixel art is a form of digital art comprised of continuous color gradations.

When color is critical: you must provide Miratec Systems a color proof that we can match. If you cannot provide a color proof, 

we’ll run your graphics “as provided” with the understanding that the color could possibly look different than your expectations.

Unacceptable color proofs: Prints via desktop printer or colors from a computer monitor

Acceptable color proofs: Matchprints, Iris, Fiery, etc.

Line Art/Vector Art

Line art is usually created in software such as Adobe Illustrator, Corel Draw or similar programs. These images are created with 

vector based shapes that are filled with solid colors or gradations between solid colors.

When color is critical: you must provide Miratec Systems with color chips, Pantone numbers or a standard vinyl color from a 3M, 

Arlon, Avery or Oracal color library that we can use to color match solid fill areas. Any critical colors should be listed in the file’s 

color swatch palette. The intended parts of the art should actually use each indicated color swatch. We can produce these 

graphics without a color reference; however, the color could possibly look different than your expectations.

COLOR

CMYK Color

Use CMYK when preparing art files for production. CMYK will most accurately reflect onto your computer monitor, the output 

color, although there may remain some subtle differences.

RGB Color

While we accept RGB files, differences in color can occur when they are converted to CMYK for production.

Resolution

Pixel images are made up of many small squares of data called pixels. The data in each individual square dictates the color that 

the pixel will print. Resolution is defined by the number of pixels in a given area of an image.

BITMAP IMAGES

Pixels Per Inch (PPI)

PPI is the most common measure of resolution. Knowing and understanding your image’s PPI is important for scaling purposes 

because the overall number of pixels in a piece of art does not change as the dimensions change. However, the PPI does change 

as the dimensions change. The pixels merely get bigger or smaller in concordance with the image size. Thus, PPI is inversely 

related to dimension; as an image is enlarged, the pixels are also enlarged and there are fewer of them per inch.

Determining Adequate Resolution

Determining adequate resolution for pixel art is dependant on the application and its true viewing distance. A billboard viewed 

from a highway 500’ away may only need to be set to 25 ppi at full scale. On the other hand, a graphic installed in an airport 

concourse, intended to be viewed from only a few feet away, may need to be 400 ppi or more at full scale.

Increasing Resolution

While there are methods for increasing the number of pixels per inch, understand that information not contained in original art 

cannot be “created”. We can increase the pixel count of an image but we cannot produce high resolution graphics from pixel 

format files that are supplied to us at low resolution.

When an image is artificially “res-ed up”, or has had its pixel count artificially increased it can “soften” the “stair step” effect but, 

at the same time, can cause the image to have a slight “blurriness.” Artificially adjusting the image’s resolution will not make the 

image look clearer or sharper.

As a rule of thumb, when working with pixel art, try to work at full scale whenever possible and determine the appropriate 

resolution based on the final viewing distance.

High Quality Resolution

High quality art is required to achieve the best printing results. When working with digital photos there is no substitute for high 

quality professional digital photography. Keep in mind that a 10 mega-pixel camera will only create a 100 ppi image when scaled 

up to 32”x32”. Techniques can be used to further enhance images, but there are always limits to what can be done, and the larger 

the output dimensions become, the more that pixel count and clarity matter.

For Example:

This 10” x 10” image has a resolution of 100ppi, while the 20” x 20” image has a resolution of 

50ppi. Both images have the same number of pixels overall, however the pixels are stretched 

over differing dimensions thus changing each image’s respective ppi.

If the output/final size of the image is large and the pixel count (PPI) is 

small, the result will reveal square, “stair step” shaped pixels as shown in 

the far right example. This may be acceptable based on a long viewing 

distance. However, in cases where your art will be viewed closely, higher 

resolution artwork may be necessary.

FILE FORMATS

Adobe Photoshop

Adobe Photoshop is a pixel based software program and the industry standard for image manipulation. 

We can accept all Adobe Photoshop generated files regardless of type; however, we do request that they are provided to 

us in CMYK mode for best results.

Adobe Illustrator

Adobe Illustrator is a vector based graphic program commonly used for type or line art either alone or in conjunction 

with pixel images.

IMPORTANT: When including type in your graphic all fonts should be converted to outlines!

To convert your file to outlines in Adobe Illustrator:

Select all elements of the graphic

Click on the “Type” Menu

Select “Create Outlines”

Adobe InDesign

Adobe InDesign is a vector based program, similar to Illustrator; however, InDesign gives the user a higher degree of control 

over text elements. When using InDesign export your artwork to a PDF document.

Corel Draw

Corel Draw is a popular program for desktop publishing and creation of graphics, however, we do not recommend using Corel 

Draw to create graphics for large format output. Art files output from Corel Draw have a tendency to have unexpected results at 

the printer, i.e. shadows, shading, pattern fills and gradients created in Corel Draw. In addition, exporting Corel Draw files out to 

other file formats such as EPS or AI can also yield unexpected results such as missing elements, color banding, etc.

With that being said, we will accept Corel Draw files, but we ask that you have all elements in CMYK mode and be sure to also 

supply us with a pixel format file (such as a JPEG) that accurately represents the desired look and layout of your graphic. This will 

enable us to confirm that no elements are missing or distorted as we go into production.

IMPORTANT: When including type in your graphic all fonts should be converted to Paths/Curves!

To convert your file to Path/Curves in Corel Draw:

Select all elements of the graphic

Click on the “Arrange” Menu

Select “Convert to Curves”
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When providing us with artwork for production, please note the following digital art requirements.

SUBMITTING ART FILES
Art files smaller than 10MB:

Art files smaller than 10MB can be attached to an email sent directly to an assigned address.  If you are a winner a 

Representative will contact you.

Art files larger than 10MB: 

Art files larger than 10MB should be submitted via the FTP (File Transfer Protocol) site which is available for customers to 

upload files into their respective, password-protected folders. If you are a winner a representative will contact you.

DIMENSIONS
Visible opening (V.O.)

The visible opening is the portion of the graphic that is visible within the framework. The V.O. dimensions assure that none of the 

graphic’s elements are hidden or obstructed by the framework/cabinet.

COLOR BLEED
Color bleed is the extra printed material necessary to accommodate a framework, if any. This is critical even if the background 

color is white. Color bleed will ensure that when your graphic is installed there will be no “light leaks” between the graphic and 

its frame. If color bleed is required, add the proper amount to your artwork before submitting your job for production.

OVERALL SIZE (O.A.)
The overall size is the size of the substrate to which the graphic is applied. In some cases this dimension may be the same as the 

V.O. plus any color bleed.

ART TYPE
Oftentimes, a graphic is composed of a combination of pixel art and line art. In this case, both of the following conditions apply 

and should be considered before submitting your art.

Pixel Art

Pixel art is a form of digital art comprised of continuous color gradations.

When color is critical: you must provide Miratec Systems a color proof that we can match. If you cannot provide a color proof, 

we’ll run your graphics “as provided” with the understanding that the color could possibly look different than your expectations.

Unacceptable color proofs: Prints via desktop printer or colors from a computer monitor

Acceptable color proofs: Matchprints, Iris, Fiery, etc.

 

Line Art/Vector Art

Line art is usually created in software such as Adobe Illustrator, Corel Draw or similar programs. These images are created with 

vector based shapes that are filled with solid colors or gradations between solid colors.

When color is critical: you must provide Miratec Systems with color chips, Pantone numbers or a standard vinyl color from a 3M, 

Arlon, Avery or Oracal color library that we can use to color match solid fill areas. Any critical colors should be listed in the file’s 

color swatch palette. The intended parts of the art should actually use each indicated color swatch. We can produce these 

graphics without a color reference; however, the color could possibly look different than your expectations.

COLOR

CMYK Color

Use CMYK when preparing art files for production. CMYK will most accurately reflect onto your computer monitor, the output 

color, although there may remain some subtle differences.

RGB Color

While we accept RGB files, differences in color can occur when they are converted to CMYK for production.

Resolution

Pixel images are made up of many small squares of data called pixels. The data in each individual square dictates the color that 

the pixel will print. Resolution is defined by the number of pixels in a given area of an image.

BITMAP IMAGES

Pixels Per Inch (PPI)

PPI is the most common measure of resolution. Knowing and understanding your image’s PPI is important for scaling purposes 

because the overall number of pixels in a piece of art does not change as the dimensions change. However, the PPI does change 

as the dimensions change. The pixels merely get bigger or smaller in concordance with the image size. Thus, PPI is inversely 

related to dimension; as an image is enlarged, the pixels are also enlarged and there are fewer of them per inch.

Determining Adequate Resolution

Determining adequate resolution for pixel art is dependant on the application and its true viewing distance. A billboard viewed 

from a highway 500’ away may only need to be set to 25 ppi at full scale. On the other hand, a graphic installed in an airport 

concourse, intended to be viewed from only a few feet away, may need to be 400 ppi or more at full scale.

Increasing Resolution

While there are methods for increasing the number of pixels per inch, understand that information not contained in original art 

cannot be “created”. We can increase the pixel count of an image but we cannot produce high resolution graphics from pixel 

format files that are supplied to us at low resolution.

When an image is artificially “res-ed up”, or has had its pixel count artificially increased it can “soften” the “stair step” effect but, 

at the same time, can cause the image to have a slight “blurriness.” Artificially adjusting the image’s resolution will not make the 

image look clearer or sharper.

As a rule of thumb, when working with pixel art, try to work at full scale whenever possible and determine the appropriate 

resolution based on the final viewing distance.

High Quality Resolution

High quality art is required to achieve the best printing results. When working with digital photos there is no substitute for high 

quality professional digital photography. Keep in mind that a 10 mega-pixel camera will only create a 100 ppi image when scaled 

up to 32”x32”. Techniques can be used to further enhance images, but there are always limits to what can be done, and the larger 

the output dimensions become, the more that pixel count and clarity matter.

For Example:

This 10” x 10” image has a resolution of 100ppi, while the 20” x 20” image has a resolution of 

50ppi. Both images have the same number of pixels overall, however the pixels are stretched 

over differing dimensions thus changing each image’s respective ppi.

If the output/final size of the image is large and the pixel count (PPI) is 

small, the result will reveal square, “stair step” shaped pixels as shown in 

the far right example. This may be acceptable based on a long viewing 

distance. However, in cases where your art will be viewed closely, higher 

resolution artwork may be necessary.

FILE FORMATS

Adobe Photoshop

Adobe Photoshop is a pixel based software program and the industry standard for image manipulation. 

We can accept all Adobe Photoshop generated files regardless of type; however, we do request that they are provided to 

us in CMYK mode for best results.

Adobe Illustrator

Adobe Illustrator is a vector based graphic program commonly used for type or line art either alone or in conjunction 

with pixel images.

IMPORTANT: When including type in your graphic all fonts should be converted to outlines!

To convert your file to outlines in Adobe Illustrator:

Select all elements of the graphic

Click on the “Type” Menu

Select “Create Outlines”

Adobe InDesign

Adobe InDesign is a vector based program, similar to Illustrator; however, InDesign gives the user a higher degree of control 

over text elements. When using InDesign export your artwork to a PDF document.

Corel Draw

Corel Draw is a popular program for desktop publishing and creation of graphics, however, we do not recommend using Corel 

Draw to create graphics for large format output. Art files output from Corel Draw have a tendency to have unexpected results at 

the printer, i.e. shadows, shading, pattern fills and gradients created in Corel Draw. In addition, exporting Corel Draw files out to 

other file formats such as EPS or AI can also yield unexpected results such as missing elements, color banding, etc.

With that being said, we will accept Corel Draw files, but we ask that you have all elements in CMYK mode and be sure to also 

supply us with a pixel format file (such as a JPEG) that accurately represents the desired look and layout of your graphic. This will 

enable us to confirm that no elements are missing or distorted as we go into production.

IMPORTANT: When including type in your graphic all fonts should be converted to Paths/Curves!

To convert your file to Path/Curves in Corel Draw:

Select all elements of the graphic

Click on the “Arrange” Menu

Select “Convert to Curves”
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When providing us with artwork for production, please note the following digital art requirements.

SUBMITTING ART FILES
Art files smaller than 10MB:

Art files smaller than 10MB can be attached to an email sent directly to an assigned address.  If you are a winner a 

Representative will contact you.

Art files larger than 10MB: 

Art files larger than 10MB should be submitted via the FTP (File Transfer Protocol) site which is available for customers to 

upload files into their respective, password-protected folders. If you are a winner a representative will contact you.

DIMENSIONS
Visible opening (V.O.)

The visible opening is the portion of the graphic that is visible within the framework. The V.O. dimensions assure that none of the 

graphic’s elements are hidden or obstructed by the framework/cabinet.

COLOR BLEED
Color bleed is the extra printed material necessary to accommodate a framework, if any. This is critical even if the background 

color is white. Color bleed will ensure that when your graphic is installed there will be no “light leaks” between the graphic and 

its frame. If color bleed is required, add the proper amount to your artwork before submitting your job for production.

OVERALL SIZE (O.A.)
The overall size is the size of the substrate to which the graphic is applied. In some cases this dimension may be the same as the 

V.O. plus any color bleed.

ART TYPE
Oftentimes, a graphic is composed of a combination of pixel art and line art. In this case, both of the following conditions apply 

and should be considered before submitting your art.

Pixel Art

Pixel art is a form of digital art comprised of continuous color gradations.

When color is critical: you must provide Miratec Systems a color proof that we can match. If you cannot provide a color proof, 

we’ll run your graphics “as provided” with the understanding that the color could possibly look different than your expectations.

Unacceptable color proofs: Prints via desktop printer or colors from a computer monitor

Acceptable color proofs: Matchprints, Iris, Fiery, etc.

 

Line Art/Vector Art

Line art is usually created in software such as Adobe Illustrator, Corel Draw or similar programs. These images are created with 

vector based shapes that are filled with solid colors or gradations between solid colors.

When color is critical: you must provide Miratec Systems with color chips, Pantone numbers or a standard vinyl color from a 3M, 

Arlon, Avery or Oracal color library that we can use to color match solid fill areas. Any critical colors should be listed in the file’s 

color swatch palette. The intended parts of the art should actually use each indicated color swatch. We can produce these 

graphics without a color reference; however, the color could possibly look different than your expectations.

COLOR

CMYK Color

Use CMYK when preparing art files for production. CMYK will most accurately reflect onto your computer monitor, the output 

color, although there may remain some subtle differences.

RGB Color

While we accept RGB files, differences in color can occur when they are converted to CMYK for production.

Resolution

Pixel images are made up of many small squares of data called pixels. The data in each individual square dictates the color that 

the pixel will print. Resolution is defined by the number of pixels in a given area of an image.

BITMAP IMAGES

Pixels Per Inch (PPI)

PPI is the most common measure of resolution. Knowing and understanding your image’s PPI is important for scaling purposes 

because the overall number of pixels in a piece of art does not change as the dimensions change. However, the PPI does change 

as the dimensions change. The pixels merely get bigger or smaller in concordance with the image size. Thus, PPI is inversely 

related to dimension; as an image is enlarged, the pixels are also enlarged and there are fewer of them per inch.

Determining Adequate Resolution

Determining adequate resolution for pixel art is dependant on the application and its true viewing distance. A billboard viewed 

from a highway 500’ away may only need to be set to 25 ppi at full scale. On the other hand, a graphic installed in an airport 

concourse, intended to be viewed from only a few feet away, may need to be 400 ppi or more at full scale.

Increasing Resolution

While there are methods for increasing the number of pixels per inch, understand that information not contained in original art 

cannot be “created”. We can increase the pixel count of an image but we cannot produce high resolution graphics from pixel 

format files that are supplied to us at low resolution.

When an image is artificially “res-ed up”, or has had its pixel count artificially increased it can “soften” the “stair step” effect but, 

at the same time, can cause the image to have a slight “blurriness.” Artificially adjusting the image’s resolution will not make the 

image look clearer or sharper.

As a rule of thumb, when working with pixel art, try to work at full scale whenever possible and determine the appropriate 

resolution based on the final viewing distance.

High Quality Resolution

High quality art is required to achieve the best printing results. When working with digital photos there is no substitute for high 

quality professional digital photography. Keep in mind that a 10 mega-pixel camera will only create a 100 ppi image when scaled 

up to 32”x32”. Techniques can be used to further enhance images, but there are always limits to what can be done, and the larger 

the output dimensions become, the more that pixel count and clarity matter.

For Example:

This 10” x 10” image has a resolution of 100ppi, while the 20” x 20” image has a resolution of 

50ppi. Both images have the same number of pixels overall, however the pixels are stretched 

over differing dimensions thus changing each image’s respective ppi.

If the output/final size of the image is large and the pixel count (PPI) is 

small, the result will reveal square, “stair step” shaped pixels as shown in 

the far right example. This may be acceptable based on a long viewing 

distance. However, in cases where your art will be viewed closely, higher 

resolution artwork may be necessary.

FILE FORMATS

Adobe Photoshop

Adobe Photoshop is a pixel based software program and the industry standard for image manipulation. 

We can accept all Adobe Photoshop generated files regardless of type; however, we do request that they are provided to 

us in CMYK mode for best results.

Adobe Illustrator

Adobe Illustrator is a vector based graphic program commonly used for type or line art either alone or in conjunction 

with pixel images.

IMPORTANT: When including type in your graphic all fonts should be converted to outlines!

To convert your file to outlines in Adobe Illustrator:

Select all elements of the graphic

Click on the “Type” Menu

Select “Create Outlines”

Adobe InDesign

Adobe InDesign is a vector based program, similar to Illustrator; however, InDesign gives the user a higher degree of control 

over text elements. When using InDesign export your artwork to a PDF document.

Corel Draw

Corel Draw is a popular program for desktop publishing and creation of graphics, however, we do not recommend using Corel 

Draw to create graphics for large format output. Art files output from Corel Draw have a tendency to have unexpected results at 

the printer, i.e. shadows, shading, pattern fills and gradients created in Corel Draw. In addition, exporting Corel Draw files out to 

other file formats such as EPS or AI can also yield unexpected results such as missing elements, color banding, etc.

With that being said, we will accept Corel Draw files, but we ask that you have all elements in CMYK mode and be sure to also 

supply us with a pixel format file (such as a JPEG) that accurately represents the desired look and layout of your graphic. This will 

enable us to confirm that no elements are missing or distorted as we go into production.

IMPORTANT: When including type in your graphic all fonts should be converted to Paths/Curves!

To convert your file to Path/Curves in Corel Draw:

Select all elements of the graphic

Click on the “Arrange” Menu

Select “Convert to Curves”
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